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Introduction 
Welcome to the Client Data System! 
Your selection of this program will increase your marketing power and streamline your office 
operation. With over 70,000 current users of CDS, including more MDRT and ICFP members 
than any other practice management program, you are joining good company. 

Over a decade of leadership in client management software has resulted in innovative functions 
you will not find in other programs. Our unique SmartPad, Letter Log, Sets and powerful 
Dynamic Reports increase your effectiveness. You will find accessing information, entering data 
and navigating through the system to be smooth and efficient. 

Key Learning Aids 
Purpose of this Guide 
The Getting Started Guide provides information about some of the basic features of the Client 
Data System (CDS). This is not a reference manual. Our online help system provides full 
documentation on the functionality of the system. 

Online Help 
Instead of a printed reference manual, CDS comes with a sophisticated online Help system. The 
Help system is available whenever you are using CDS with an Internet connection. We maintain 
the Online Help at our offices and provide the latest updates as they become available. When you 
are disconnected, a smaller version of the Help is available on just your local system. Online Help 
saves you time when you need answers to your questions. If necessary, you can print help topics 
for future reference. 

E-Z Data Web Site (www.ez-data.com) 
The E-Z Data Web site offers quick, up-to-date information about CDS. From this portal, you can 
access the CDS Training Center to view training movies covering the five core CDS courses: 
Introduction to CDS, The Client File, The CDS Calendar, CDS Mail Merge, and Filters, Sets, and 
Dynamic Reports. You can also exchange information with other CDS users through the E-Z 
Data Forum and find help with a CDS Technical Support knowledge-base query. 

Fast Classes 
Fast Classes are brief tutorials that spotlight advanced tools and functionality in CDS, serving as 
a supplement to the Core Courses offered on the E-Z Data Web site. Every other week, a new 
Fast Class is published and sent through e-mail to registered CDS users. A comprehensive list of 
previously published Fast Classes can also be found on the E-Z Data Web site. 

CDS Overview 
Before installing the program, review some of the key windows and functions in CDS. The Quick 
Tour of CDS begins on page 21. 
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Optional Modules 
The modular design of CDS enables you to add capabilities as needed. Optional CDS modules 
include: 

• The Investment Tracking Module for tracking investment activity and generating reports 
for each client. 

• The Transaction Download Module for downloading and processing financial data 
distributed by data providers, and automatically updating client investment records.  

• The MobileMerge Module that enables you to take your data with you while you are away 
from the office. Copy the data from your CDS database onto a portable computer, then add or 
modify the data while you are in the field. When you return to the office, merge any data 
changes from the portable computer to your CDS database. 

• The Commission Tracking Module for calculating and tracking agent sales commissions. 

• The Pending Case Management Module for tracking new business from the date of 
submission to paid case status, and generating sales production reports. 

• The E-Z Mobile PDA Module will open the way to true portability for your data. With your 
Personal Digital Assistant (PDA), you can download contact and activity records to take with 
you when you are away from the office. 

The Laser App Integration Module provides users a one-step process for exporting CDS 
Contact data into standard industry forms provided by Laser App (www.laserapp.com). A copy of 
the Laser App software is required to use this module.
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Getting Started 
Conventions in This Guide 
Menu commands and buttons or icons that are clicked with your mouse, as well as keyboard 
actions, appear in a bold font: for example, File menu, Run command, OK button, TAB key. 
When information is required in a field, the characters appear in a different font. 
References to the Online Help topics display in an underlined font: for example, Using the 
SmartPad. 

The CDS Additions to the Start Menu 
CDS Folder 
This folder is created under the Programs menu and contains all of the Client Data System icons 
and a sub-folder called CDS Utilities. 

Client Data System 
Click this icon to start the program. 

Client Data System Online Help 
Click this icon to open the CDS Online Help System. Ensure that you have an active Internet 
connection to view the latest version of the Online Help System for CDS. 

E-Z Data Training and Support 
Click this icon to open the E-Z Data’s Training and Support Web site. Ensure that you have an 
active Internet connection to view this site. 

CDS Utilities Sub-folder 
This sub-folder contains Database Utilities, E-Z Configuration and the ODBC Administrator 
programs that can be used to set up and maintain your CDS system. 

Database Utilities 
The CDS Database Utilities icon provides access to three general-purpose database utilities: 
Database Validate, Backup Database and Database Rebuild. 

The Database Validate utility is used before backing up a database to verify the integrity of a 
database’s structure. 

A comprehensive backup of valuable CDS data is essential for data protection. Use the Backup 
Database utility with high quality storage media and up-to-date antivirus software to protect the 
databases. 

After downloading, importing, or making numerous database changes, the database index should 
be rebuilt. Use the Rebuild Database option on a regular basis. 

E-Z Configuration 
Use this utility for troubleshooting connectivity problems between a workstation and the server. 

ODBC Administrator 
E-Z Data, Inc. recommends only using this utility with the guidance of E-Z Data (or Microsoft) 
Technical Support staff. This Data Sources utility is a Microsoft product. 
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Logging In 
All users must log in to CDS before they can access client data. 

For ease of learning, a sample database is provided for your use in exploring CDS. To log in to 
the sample database, use the Database name DEMO and the user name DEMO while following 
these instructions: 

1. From the Taskbar, click the Start button, point to Programs, then Client Data System, and 
then click Client Data System. 

2. Select DEMO from the Database drop-down list. 

 
3. Type in the name of the User in the second field. 
4. Type in your password into the third field and then click the OK button to start the login 

process. Note that all user logins require a password. 
5. The Login dialog box closes as the CDS program opens. 
The first time you login to CDS after installation, several messages will be displayed while data 
initialization occurs. When the initialization is complete, CDS is ready for use. 
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Setting Up CDS Features 
Printer Setup 
CDS uses the Windows Print Setup to control printing operations. To see or change the list of 
printer options while using CDS, use the Print Setup command on the File menu. 

FaxMan (Fax Server) 
FaxMan is an add-on program that enables you to send faxes directly from the CDS program. If 
you have a compatible modem and printer configuration, FaxMan is installed automatically when 
the CDS program is installed. However, due to the wide variety of modems and printers that are 
available, FaxMan may not function with all system configurations. 

Automatic Dialing Setup 
You can dial telephone numbers from Contact and Business records in CDS databases through 
your computer’s modem. 

In CDS, click Database and select Modify Current User’s Profile to open the user profile setup. 
Click the Misc. Information tab in the user profile to see or change the Modem/Phone 
Information settings. 

Refer to the Help system topic About the User Profile for additional information. 

Protecting Your Data 
You can help prevent the total loss of your data by backing up your valuable data nightly. A 
nightly backup is the best way to keep your data loss to a minimum in the event of an 
unrecoverable hard drive crash. Less frequent backups equate to more significant losses, while no 
backup could mean the total loss of your data. 

CDS system and data files for stand-alone installations are located under Program Files in the 
CDSWin directory by default. For network installations, CDS system and data files are located in 
the CDSWin.svr directory on your server. 

There are many backup systems available on the market today. Use of tape backups or 
recordable/rewritable CD-ROM systems (CD-R/CD-RW) provide the highest capacity and are the 
most reliable. Spanning your backup across several diskettes is not recommended because of the 
increased risk of losing your entire backup due to the failure of a single disk in the set. 

Rotate your backup tapes or CD-R/CD-RWs so that you have multiple copies of your CDS 
system and data files in the event of defective media. At least one current backup should be kept 
off-site in case of fire or other disaster. 
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Getting Acquainted with the Desktop 

 
The first window that displays after logging in to the program is the CDS desktop. The desktop is 
comprised of various elements: 

Title Bar – The title bar displays the program name, the name of the database that is open, and 
the name or the user that is logged in. 

Menu Bar – The menus on the Menu Bar contain the complete set of commands and utilities that 
are available to the user, based on the area of the program that is open. For example, from the 
CDS desktop, the user can access Sets, Filters, and Images from the View menu. When a Contact 
record is open, additional commands and options display on the View menu. 

Toolbar Buttons – The toolbar buttons are used to access the most commonly used features that 
are available on the various menus. 

Status Bar (not shown) – Indicator buttons for the active Contact are located in the Status Bar at 
the bottom of the CDS desktop. Indicator buttons are shortcuts to additional information about the 
Contact, such as policies, investments and scheduled activities. 

Field Help is also displayed in the Status Bar. Each field of a database record is labeled according 
to use of the field. While the use of some fields, such as Last Name or Birth Date, is obvious, 
brief reminders on the status bar describe the function of less obvious fields when they are 
selected. When you move to the next field, the message changes to remind you of the type of 
information that belongs in that field. Field Help messages can be changed to suit individual 
needs. 

CDS Menus and Toolbar Buttons 
The desktop menus and toolbar buttons access all CDS functions. The most frequently used menu 
commands are available by clicking the toolbar buttons. When you point to a button, a ToolTip 
describing the button’s functionality displays. 

Some functions are available in all windows, while other functions are only available when 
certain records or list windows are open. 

Toolbar buttons that are always available: 

Help       Contact                            DayView            Online Help 

Calculator                      MonthView       SmartPad  

 

                           Messages                          WeekView               Dial Phone 

          Close                     Business  Reports  
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Toolbar buttons that are common in many areas of the program: 

Find       Save                            ActivityLog                   Images 

                    Next                     Modify                         Investments  

 

                         Add Record                           Letters                    Pending Case Management 

         Previous                    Delete Record  Policies  

  
Pause/Continue                           Filter                                      Spreadsheet Correspondence  
              Mass Modify                                  Sort Asc.        Print/Fax 

 

                                        Tag All                            Sort Desc.              Customize Layout 

         Run               Sets                        Unfilter                       Dynamic Reports          Activities  

For more information, see the Online Help topic Customizing CDS. 
Online Help 
CDS provides online help in lieu of a printed reference manual. Knowing how to access and use 
the online help is particularly important. If you are already familiar with using online help 
systems for Windows programs, you can skip this section and move on to Creating a New 
Database on page 8. 
Finding Help 
Online Help is available from anywhere in the program. Open the main CDS Help, Glossary, or 
Help for specific modules by selecting one of these items from the CDS Help menu. For general 
information about how to use the Windows Help system, select Using Help from the CDS Help 
menu. The Help buttons in dialog boxes open help topics about the dialog box that you are using. 

Please note that the CDS Help System is now maintained online. In order to view the latest 
version of the Help System, a system needs to be connected to the Internet. When using a system 
that is not connected to the Internet, a local copy of the file that contains less content is used. 

 

Client Data System® v6.0 - Getting Started Guide 
Revised: 12-27-05 

Page 7 



Jumps and Pop-ups 
Glossary terms in the local Help system are green with a dotted underline. When you click on a 
glossary term, a pop-up window opens with a definition or additional references for the term. 
Click again to close the window. 
Words or phrases in green with a solid underline indicate that there is a separate topic for the 
word or phrase. Click the word or phrase to jump to the other topic. Click the Back button to 
return to the previous topic. 
Many of the images in the Help system have imbedded information about the fields and buttons 
that appear in the image. Whenever the mouse pointer changes to a pointing hand over an image, 
you can click on that area of the image to open a pop-up window for additional information. 

Using the Index and Search Tabs 
Key words and phrases are fully indexed in both the local and online Help systems. In the online 
Help system, select the Index button above the table of contents and start typing the word or 
phrase that you need help with. As you type, matching words or phrases are automatically located 
in the index. Click the word or phrase that you are looking for to display the corresponding help 
topics. 
The Help systems also have a full-text search capability for locating all occurrences of an exact 
word or phrase. In the online Help system, select the Search button above the table of contents, 
enter the word or phrase that you want to find in the Search field and then click the Go button. 
Any topics that contain the word or phrase that you are searching for are displayed. Click the 
topic title to display the corresponding Help topic. 

Printing Help Topics 
If you have a local or network printer attached to your computer, you can print help topics for 
future reference. Locate the help topic that you want to print and then click the Print button on 
the toolbar. 
Creating a New Database 
The CDS program comes with a demonstration database named DEMO. This database contains 
fictitious records for Contacts, Businesses, Policies, etc. to help illustrate the various features of 
the program. Use the DEMO database to practice using the program and to follow the examples 
in this Getting Started Guide. When you are ready, create your own database by following the 
steps below. 
1. Start Client Data System and login to the DEMO database as the DEMO user. 
2. From the Database menu, select Create New Database and then click OK in the warning 

dialog box. 
3. In the Create Database dialog box, enter the name for your new database (up to eight 

characters, no spaces or special characters). 
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4. Press the TAB key to move to the Drive/Path field. 

Notice that the database name automatically becomes the name for the Path. In our example, 
the new database will be located in C:\Program Files\CDSWin\Clients. 

If you are using the network version of CDS, the database will be stored on the network 
server. Please consult your network installation instructions for further details. 

5. Press the TAB key to move to the User Name field. To create your own CDS user name, type 
in your name (up to eight characters, no spaces or special characters). 

6. Create a password for the user name. All CDS user logins require a password. 

7. Enter the password again in the Confirm Password field. 

8. Click the OK button to close the dialog box and create the new database. 

9. When CDS is finished creating the database, click the OK button to log in to and use the new 
database. 

CDS maintains a User Profile of system preferences for each user’s login name. The next time 
you start CDS, you will have the choice of logging in to the DEMO database, or the new 
database. 

For more information, see the Online Help topic: About the User Profile. 

Logging into Other Databases 
You can close one database and log in to another at any time. For example, you may want to log 
in to the DEMO database for additional practice and follow the exercises in this guide. 

1. Save and close any open work, such as Contact records, to return to the CDS desktop. 

2. From the Database menu, select Login to New Database/User. 

3. When the Login dialog box opens, select the DEMO database, type in the DEMO user name 
as well as the password you created and then click the OK button to open the practice 
database. 
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Keyboard Shortcuts 
The shortcut keys for CDS commands are listed to the right of the respective commands on the 
menus. In addition to command shortcuts, many users find that shortcut key-combinations for 
simple navigation are quick and efficient. The keys listed below are used to navigate through the 
program from the keyboard. 

TAB (SHIFT+TAB) Moves the cursor to the next field for data entry. (To move 
to the previous field, press SHIFT+TAB.) 

ALT+RIGHT ARROW In a tabbed window, such as the Contact window, this key 
combination opens a horizontal tab to the right of the 
current tab. 

ALT+LEFT ARROW In a tabbed window, such as the Contact window, this key 
combination opens a horizontal tab to the left of the current 
tab. 

ALT+DOWN ARROW In a tabbed window, such as the Policy window, this key 
combination opens a vertical tab below the current tab. 

ALT+UP ARROW In a tabbed window, such as the Policy window, this key 
combination opens a vertical tab above the current tab. 

CTRL+TAB Use this key combination to move from one active window 
to another. For example, when you have multiple windows 
open, each time you press CTRL+TAB another open 
window becomes the active window. 

CTRL+F4 Use this key combination to close the active window. 

F2 Many fields have drop-down lists of choices. The F2 key 
opens the Choice Options dialog box to add or delete 
choices. 

F3 The F3 key opens the Dialing dialog box from open Contact 
or Business records for dialing phone numbers through your 
computer’s modem. 

F7 The F7 key opens the SmartPad list window for the active 
Contact or Business record. 
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The Basics 
The exercises in this guide are based on the DEMO database that is installed with the CDS 
program. This database contains fictitious records for Contacts, Businesses, Policies, etc. to help 
illustrate the various features of the program. Use the DEMO database to practice using the 
program and to follow the examples in this guide. 

Opening the Contact Window 

 
From the Desktop: 

1. From the File menu, select Contact or select the Contact button on the toolbar to open the 
Find Contact Information dialog box. 
(This dialog box is used to select the Contact records that you want to open. Detailed 
information about using the Find Contact dialog box begins on page 12.) 

2. For this exercise, click the OK button to list all of the Contact records in the database. 

3. Double-click a record in the Summary tab list to open the Personal tab for the Contact. 

For Online information, see the Help topics: Overview of the Contact Window and Finding 
Records. 
Adding Contact Records 
From the Desktop: 

1. From the File menu, select Contact or select the Contact button on the toolbar to open the 
Find Contact Information dialog box. 

2. Click the OK button in the Find Contact Information dialog box to list all of the Contact 
records in the database. 

3. From the Record menu, click the Add button or click the Add button on the toolbar of the 
Contact Summary tab. 

4. Begin entering information about the Contact when the blank Contact record opens. As you 
enter information, the first letter of each name or word in a field is automatically capitalized 
for your convenience. Use the TAB key or the mouse to move from one field to the next. 
Some fields have drop-down lists of choices. These choice lists help you maintain 
information consistency and can be modified to suit your needs. 

5. After adding information about the Contact, click the Save button. As the record is being 
saved, you will be prompted to assign the Contact to at least one Agent/Producer from a list 
that will open automatically. Select an Agent/Producer from the list and then click the OK 
button to finish saving the new record. 

New Contact records must be saved before additional information can be added on other tabs. 
The other tabs become available for data entry after saving the record. 

The Contact name displays in the title bar of the record window after saving the record. While 
working on a Contact record, all functions and data entry are automatically linked to that record. 
For example, if Joe Ackerman’s contact record is open when you click the SmartPad button, all of 
the SmartPad entries for Joe Ackerman are displayed. Click the Policies button and all of Joe 
Ackerman’s policies are displayed. 

For more information, see the Online Help topic: Adding a Contact Record. 
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Finding Contact Records 
There are several methods for finding specific contact records in the database. If you do not have 
records in your new database, login to the DEMO database to follow the exercises below. 

From the Desktop 
1. From the File menu, select Contact or select the Contact button on the toolbar to open the 

Find Contact Information dialog box. 
2. When the Find Contact Information dialog box opens, enter a last name, a business name, or 

some other unique information about the Contact record you are looking for, and then click 
the OK button. 
Any records that match your search criteria are listed on the Summary tab of the Contact 
window. If there is no match for your search criteria, you will be prompted to add a new 
Contact record. 

3. To view the pertinent details of any record listed as the result of the search, select the record 
on the list and then click any other adjacent tab. 

For more information, see the Online Help topic: Finding Contact Records. 

Browsing for a Contact Record 
When you have many Contacts with the same last name, you can browse for the exact record that 
you are looking for without closing the current Contact record first. 

1. Search for Contact records with a common last name using the method described above. 
2. Select one of the records from the Summary tab that were found during the search and then 

click the Personal tab. 
3. Click the next or previous button (right and left arrow on the toolbar) to open the records that 

display alphabetically before or after the current record. 
Finding Other Contact Records 

When the Contact window is already open, you can find other Contact records that were not on 
the Summary tab, or that are out of alphabetical browsing order, without closing the active 
Contact record. 

1. Click the Find button to open the Find Contact Information dialog box.  
2. Enter the last name of the Contact that you are looking for in the Find Contact Information 

dialog box and then click the OK button. 
If you are not sure about the spelling of a Contact’s last name, enter the first letter or the first 
few letters of the name to locate all records that begin with the letters that you enter. This 
method of searching for partial information will work in the other fields also. 

3. Records that match the search criteria will be displayed on the Summary tab of the Contact 
window. Select a record on the summary list and then click the Personal tab to view detailed 
information about the Contact. 
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Key Relations 
The Key Relations tab of Contact and Business records stores information about important 
relationships. Relationships include the spouse, sons, daughters and business associates. When a 
relationship involves other Contacts or Businesses that have records in your database, you can 
link the records together and define the relationship. Use the DEMO database if you want to try 
this out without modifying your own data. 
Linking Contact Records: 

1. Open the first of two Contact records that you want to link together. 
2. Use ALT+RIGHT ARROW to move to the Key Relations tab; or, click the Key Relations 

tab. 
3. In the Key Relations Summary section, click the Add Record button, or select Add Key 

Relation from the Record menu. 

 
4. In the Find Contact Information dialog box, type the first letter of the other Contact’s last 

name in the Last Name field and then click the OK button. 
5. In the list window showing all contact records with last names beginning with the letter you 

typed, double-click the name of the contact that you want to link. 
6. In the Define Relationship dialog box, select the relationship type and the specific 

relationship for each Contact from the drop-down lists and then click the OK button. 
This defines the relationship for the two contacts. CDS has a default list of key relationship 
descriptions you can use, or you can enter your own by clicking on the Relationships button. 

7. On the Key Relations tab, select the linked Contact’s name and then click on the Show 
Contact button on the toolbar to open the second Contact’s record. 

When the second Contact’s record opens, you will find the first Contact’s name listed on the Key 
Relations tab. Follow the procedure in Step 7 to re-open the original Contact record. 

For more information, see the Online Help topic Contact (Client) Records. 
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Dependents 
You can store brief information about family members, such as dependent children, in the Key 
Relations tab of the Contact record. The dependent record displays on the right side of the Key 
Relations tab. There is no Contact record (or Contact record functionality) for a dependent record. 

1. Open a Contact record and then click the Key Relations tab. 
2. In the Key Relations Summary section, click the Add Dependent button (to the right of the 

Add Record button). 
3. Type the Last Name and First Name of the dependent in the Find Dependent Record dialog 

box, and then click the OK button. 
4. Click the Yes button when the CDS program indicates that the record for the name entered 

does not exist and prompts you to add it.  
5. In the Quick Add/Modify dialog box, fill in the fields as needed and then click the OK 

button. Address and Phone information can be added or you can click the OK button to be 
prompted to add this information from the main contact. 

6. When the Define Relationship dialog box opens, select Relation Types from the drop-down 
lists and then click the OK button to save the Dependent record. 

For more information, see the Online Help sub-topic Working with Dependent Information under 
Contact (Client) Records. 

Additional Contact Record Tabs 

• The Add’l. Personal tab stores miscellaneous information, dates, set membership and record 
assignments. 

• The Benefits tab displays the Contact’s insurance and investment totals in read-only fields. 

• The Contact Custom Fields tab contains numerous fields that can be customized by the user 
for virtually any type of data storage and retrieval need. 

Storing Policy Records 
You can create policy, product, vendor and agent records in CDS. The DEMO database has 
completed examples of these types of records. 

Opening the Policy Window 
1. Open Joseph Ackerman’s Contact record. 
2. Click the Policies button on the toolbar to display a summary of Joseph Ackerman’s policies. 
3. Open the View menu to change the options that control the types of policies that are 

displayed or to display policies by a specific role. 
Navigating in the Policy Window 
The Policy window has tabs across the top to organize information about a specific policy. The 
tabs along the left side organize the policies by type. 
1. Double-click any policy that is listed on the Summary tab to view the details of that policy on 

the Basic Information tab. 

 
Use the “three dimensional” field name buttons to access data stored 
elsewhere in CDS. For example, click on the Carrier field name button to 
open the Insurance Vendor record. Use the field buttons when adding new 
records to help eliminate typographical errors, and to maintain uniform data 
entry. 
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2. Click the PlanName/Code field button. The information that displays in the pop-up window 
is from a related table in the database. Click the Cancel button to close the window without 
making any changes. 

3. Click the Benefits tab to display details of coverage and riders. Data entry and field buttons 
work the same way in this tab as they do in nearly all of the CDS windows. 

4. The Misc. Information tab stores policy-related dates, subaccount information and custom 
fields. The Transaction tab stores transaction histories and summaries for the types of 
policies where transactions occur. 

5. Review the different types of policy information stored by clicking a vertical tab and then 
repeating the previous steps. 

For more information, see the Online Help sub-topic Navigating the Policies Windows under 
Policy Records. 

Adding a Policy for a Contact  
1. Open the Contact record and then click the Policies button to open the All Policies Summary 

tab. 
2. Select the vertical tab for the type of policy that you want to add. For example, click the Life 

tab to add that type of policy. 
3. From the Record menu, select Add or click the Add Record button. 
4. On the Basic Information tab, enter the policy data. 
5. If the Carrier field is blank, click the Carrier field button to open the Find Insurance Carrier 

Information dialog box to locate the Insurance Carrier to use for the type of policy that is 
being added. 

6. The Plan Name/Code field has a drop-down list of Insurance Products for the selected 
Carrier. Click the Plan Name/Code field button to add a new product. 

7. If the Primary Agent field is blank, click the Primary Agent field button to open the Find 
Agent/Broker/Producer Information dialog box. If the field is populated, click the Primary 
Agent field button to modify or add agent information to the database. 

8. Click the Proposals field button to link a Sales Illustration record to the policy. This button 
becomes active after the new policy record has been saved. 

9. When you click the Save button, you will be prompted to enter Interested Parties (e.g., Payor, 
Beneficiary, etc.), Split Cases and Commission Schedules if applicable. 

10. Click the Primary Agent Selection button to access the Related Agent List for the Policy 
where Agents can be added, modified and deleted as necessary. 

11. After saving the record for the first time, you can enter Riders on the Benefits tab as needed. 
For more information, see the Online Help sub-topic Working with Policy Records under Policy 
Records. 
Telephoning a Contact 
Before you use the automatic dialing feature, make sure you have set up your computer modem 
and have the correct settings in your User Profile (see Automatic Dialing Setup on page 5). 

1. Open Joseph Ackerman’s contact record. 
2. Click the Dial Phone button on the toolbar or press F3 on your keyboard to open the Dialing 

dialog box. This dialog box lists all of the telephone numbers stored in the contact record. 
3. If this were an actual Contact that you wanted to call, you would click the Dial button to have 

CDS dial the selected number through your modem. 
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4. Since Joe Ackerman is a fictitious Contact, make sure the Manual Dial box is checked and 
then click the Dial button. When the timer starts, Stop and Pause buttons display on the right 
side of the status bar. 

5. Click the Stop button to open the Time Log Information dialog box. Use this dialog box to 
add notes or other pertinent information about the call and then click the OK button to save 
the Time Log Information. 

CDS maintains a log of your timed calls and activities. Select Time Log Information from the Tools 
menu to view these records. Time Log entries also display in the Contact’s SmartPad. 

For more information, see the Online Help sub-topic Contact Phone Numbers under Contact 
(Client) Records. 

Scheduling Appointments 
During a conversation with a Contact, you may decide that you need to schedule an appointment 
to review a proposed policy or discuss other business. 

1. Open Joe Ackerman’s contact record and then click the WeekView button on the toolbar. 
You can also schedule appointments from the DayView, MonthView and the Contact’s 
Activity Log. 

2. Select the year, month and day for the appointment from the WeekView calendar. If the 
calendar is not in view, click the WeekView button again to change the view. 

3. Double-click one of the rows under the date selected to open a DayView calendar window. 
4. Select a row adjacent to the time when you want to schedule the appointment and then click 

the OK button to open the Activity Detail dialog box. 
5. Use the TAB key to move from one field to the next (or click in a field) if you need to change 

or add information. Click the Options button to link the activity to an existing policy (or 
investment). 

6. When you are finished adding or changing information for the activity, click the OK button 
to close the Activity Detail dialog box. For this exercise, make sure Appointment is the 
activity Type. 

7. When the Activity Detail dialog box closes, you will be prompted to send a confirmation 
letter about the scheduled appointment. Click the Yes button and then continue with the next 
exercise. 

For more information, see the Online Help topics under Time and Calendar Management. 

Sending a Confirmation Letter 

There are two ways to create and send appointment confirmation letters: 

Automatic Confirmation Letters 
1. After scheduling an Appointment-type activity, as in the previous exercise, CDS 

automatically prompts you to send a confirmation letter. Click the Yes button when prompted 
to send a confirmation letter to open the Print/Fax Form Letter dialog box. 

2. Select the Appointment Confirmation letter from the list of Form Letters (the DEMO 
database has sample confirmation letters) and then click the Print button. 

3. The confirmation letter opens in a word processor and all merge codes automatically expand. 
Confirm the Contact information and the content of the letter and then click the Close button. 
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4. When the word processor closes, you will be prompted to send the letter to the printer. Click 
the Yes button to send the letter to the printer or the No button to cancel the creation of the 
confirmation letter. 

Creating Confirmation Letters Manually 
1. Open Joe Ackerman’s contact record and then click the Letters/Documents tab. 
2. In the Letters section, a list of letters that have been sent to Joe is displayed. 
3. Click the Add button to open the Letters window to send him a form letter or write a new 

one. 
4. From the Letter window, select Print a Form Letter and then click the OK button. 
5. In the Find Form Letter dialog box, click the OK button to list all form letters that are 

available for import. 
6. Locate and select the Appointment Confirmation letter in the Description column and then 

double-click it or click the Print button to open the letter.  
The Appointment Confirmation letter contains some basic Merge Codes (symbols and words 
that merge information from database fields). You can insert additional codes by using the 
Merge Code Browser. This feature is available from the Tools menu in E-Z Editor or the 
Insert menu if you are using Microsoft Word with CDS. 
Locate the Merge Code &Date at the top of the letter. When the letter is printed, the current 
date will be inserted in place of this Merge Code. Other Merge Codes, such as &Name and 
&Address, will be replaced by the data stored in the respective database fields when the 
letter is printed. The text can also be changed. 

7. To expand the merge codes, from the Tools menu, select Expand Merge Codes (E-Z Editor 
and Microsoft Word). When prompted, select the type of address to use to complete the 
process. 
If this were an actual Contact, the confirmation letter could now be printed and sent to the 
Contact. When you save this letter, the letter is stored in the Contact’s Letters and Documents 
tab exactly how it was printed, without changing the format or text of the form letter that was 
imported in Step 6. 

 
To print the Appointment Confirmation letter without making any changes, 
select Form Letters from the Reports menu. This method starts the letter 
printing process without opening the letter in a word processor. 

For more information, see the Online Help sub-topic Form Letters and Mail Merge under Word 
Processing. 

SmartPad Notes 
The SmartPad is a collection of notes and events associated with a Contact. SmartPad entries 
occur automatically for a variety of actions, such as scheduled appointments, notes on telephone 
conversations, change of address and policies and investments added. The settings in your User 
Profile control the types of events that are automatically recorded in the SmartPad. You can also 
make manual entries in the SmartPad. 

When the SmartPad window is open, you can apply a Filter that will only display SmartPad 
entries of a certain Type or Priority. 

1. Open Joe Ackerman’s Contact record. 
2. Click the SmartPad button on the toolbar, or press F7 on your computer keyboard. 
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3. Scroll to the end of the list to see the timed telephone session, the appointment you made and 
the confirmation letter you sent (if you completed the exercises from the previous sections). 

4. In the Type column, locate a SmartPad entry with Activity as the type. Double-click this 
SmartPad entry to open the Activity Detail box for the entry. When you double-click a 
SmartPad entry for a Policy, the Policies window opens to the Basic Information tab for the 
linked policy. When you double-click a SmartPad entry for a Letter, a copy of the letter 
opens. 

For more information, see the Online Help topics under SmartPad: The Intelligent Notepad. 

Consolidating SmartPad Notes 
You can consolidate the SmartPad entries of family members and other Contacts into one 
SmartPad list. 

1. Open the Contact record for Kathleen Ackerman (Joe’s wife) and then open her SmartPad (as 
described above). 

2. Take note of the number in the SmartPad title bar that indicates the number of entries 
displayed. 

3. Click the Consolidation by Household button, or select Household SmartPad from the 
Tools menu. 
The SmartPad list is redisplayed with the SmartPad entries for all members of the Ackerman 
household. Notice the number in the SmartPad title bar has increased to indicate that more 
entries have been displayed. 

 
SmartPad entries display in chronological order so that you can quickly see 
the sequence of events for a family or key account. 

4. Click the SmartPad button to redisplay only Kathleen Ackerman’s SmartPad entries. 
To limit the list of family members, click the Consolidated SmartPad button to open the 
Consolidated SmartPad dialog box. Select the family members on the list that you want to display 
SmartPad entries for and then click the OK button. You can also add other Contacts to the 
Selected Contact List by using the Find, Filter and Set buttons. 

Database Reporting 
CDS supports several powerful reporting features. The innovative Dynamic Reports function can 
be used to create report setups that are based on the records you specify and in the format you 
define. For example, create a report that will include all Contacts with birthdays occurring in the 
next 30 days, sorted by month and day of birth. With the click of a button, run the report to 
display the Contacts that fit the reporting criteria, and then double-click any of the records to 
dynamically access the underlying Contact record. 

Opening the Reports List 
Close any windows that you may have opened in other exercises. You can use Close All on the 
Windows menu to conveniently close all open windows. 

1. On the toolbar, click the Reports button (or press CTRL+Y) to open the Find Report 
Selection dialog box. 

2. Click the OK button in the Find Report Selection dialog box to list all available reports. 
The Category column of the Report Selection window indicates the primary table that is used in the 
report. For example, Activity in the Category column means that the Activity table is the primary 
table. Like other list windows in the program, you can sort or filter the list, change the arrangement of 
the columns, etc. 
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When you click the Add button, you will be guided through the steps required to add your own 
Dynamic Report by the Report Definition Wizard. Please review the CBT on the companion CD 
for a complete demonstration of this multi-step process. 

Additional information is also available in the Online Help sub-topic Creating a Dynamic Report 
under Database Reporting. 

Running Reports 
1. Open the Dynamic Reports Selection list and locate the “All Married Clients” report in the 

Description column. 
2. Select the All Married Clients report on the list and then click the Run button. 
3. When the Select Agent(s)/Producer(s) dialog box opens, click the Select All button and then 

click the OK button. 
The results of the report will display in a list window. You can print the report in spreadsheet 
format (as it appears on-screen) or open a Contact record by double-clicking the Contact’s name 
on the list. 

For more information, see the Online Help sub-topic Running Reports under Database Reporting. 

Sets of Records 

Sets are used to group records together that have something in common. For example, you can create a 
Set for Contacts who earn more than $100,000 per year, or a Set for Contacts who are physicians. 

When you open a Set of records, the Set members are displayed in a list window. Add to and remove 
records from the set with filters or by manual selection. 

There are several examples of Sets in the DEMO database. As you add client and prospect 
records to CDS, you can group the records into new or existing Sets for use with other program 
features. 

1. Close any CDS windows that were opened during previous exercises. Click the Sets button 
on the toolbar, or click the View menu and select Sets. 

2. Click the OK button in the Find Sets dialog box to open the Set List. 
Each Set has a Name, Description and other pertinent details about the Set. You can create 
new Sets or modify existing Sets. Use the Validate command on the Record menu to make 
certain a Set is up-to-date before using it for other tasks. 

3. Double-click the MD Set to open it. 
The MD Set Members window lists all of the Contacts who are designated as a Physician in 
the Occupation field of their records. You can double-click on any name in the list to open 
the underlying Contact record. Contact records can be added to a Set automatically during the 
data entry process or you can add records manually to a Set at any time. 

For more information, see the Online Help sub-topic Using Sets under Filters and Sets. 

Changing CDS Features 
List windows use the default column headings and widths to display records and other data. You 
can change the width of columns in a list window with the mouse, or you can use the Column 
Definition dialog box to resize, add, remove and change the order of columns. 
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Resizing Columns 

1. Open the MD Set Members list if it was closed after the previous exercise. 
2. Move the mouse pointer over one of the column boundary lines on either side of a column 

heading. 

 
3. When the mouse pointer changes from an arrow to a split line , press and hold the mouse 

button while dragging the boundary line in either direction to change the column width. 
Release the mouse button when the column is set to the preferred width. 

Customizing the Layout 
Use the Column Definition dialog box when you want to add, remove, or rearrange the available 
columns, in addition to resizing the columns to your preference. 

1. From the list window toolbar, click the Customize Layout button to open the Column 
Definition dialog box. 

2. Locate and select Title in the Columns Available list. 
3. Click the right arrow button to move Title to the end of the Columns Selected list. You can 

also double-click Title to move it to the Columns Selected list. 
To change the order of the Columns Selected: use the mouse to point to the column name that 
you want to move, press and hold the mouse button while dragging the column name to a 
new position on the list, and then release the mouse button. 

4. Locate and select First Name in the Columns Selected list. 
5. Click the left arrow button to move First Name to the Columns Available list. You can also 

use the double-click method to remove columns. 
6. The selected columns appear in list-order along the top of the Column Definition dialog box. 

Use the resizing method described previously to change the column widths as needed. 
7. When you click the OK button to save the changes, a dialog box will prompt you with the 

option to save the changes for All Users or For the current user only (default option). Click 
the Save button after selecting an option to finish saving the changes. 

For more information, see the Online Help sub-topic Using List Windows under CDS Basics. 

Creating Field Choices 

The data in many Contact and Business record fields is unique to each person or business. Some 
fields, however, can be used for data that is common to many or all Contact and Business records. 
With common data in certain fields, efficient sorting, grouping and searching functions can be 
performed. The key to efficient sorting, grouping, or searching functions is uniform data entry. 

To help you maintain the uniformity of data, most data fields have Choice Options lists that can 
be customized with any preferred terms to use in the field. For example, you could add the term 
“Lawyer” to the Choice Options list of the Occupation field to help you avoid using “Attorney” 
or “Counselor” to identify this type of legal professional. Using consistent terms in this case 
would eliminate the need to search the database multiple times to find all Contacts who are 
basically in the same profession. 
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Joseph Ackerman’s occupation is listed as Physician/Surgeon. To avoid using inconsistent terms 
for other Contacts in this profession, add Physician/Surgeon to the Choice Options list. 

1. Open the Personal tab of Joseph Ackerman’s Contact record and then TAB to the 
Occupation field. 

2. Right-click in the Occupation field to open the context menu. 
3. Select Choice from the context menu to open the Choice Options dialog box. 
4. Click the Add button to use the Choice Options dialog box in Add Mode. 
5. Type Physician/Surgeon in the Add Mode field and then click the Save button. 
6. Click the Add button to add other occupations or click the Close button if you are finished. 
When you close the Choice Options dialog box after adding choices, a drop-down list will be 
created for the field. Make selections from the drop-down list in the field to maintain consistency 
when adding new Contacts. 
For more information, see the Online Help sub-topic Field Choices under Customizing CDS. 

Quick Tour of CDS 
Contact Management 
Track clients using specially designed Contact or Business record formats. Select a record on the 
Summary tab and then click any other tab to view the Contact information. 

The Personal information tab stores details about an individual Contact. 
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The Add’l Personal tab expands upon the Contact’s Personal information. 

 
Use the Key Relations tab to link related Contact or Business records, by any relationship 
category, for instant access and consolidated reporting. 
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The Benefits tab provides a read-only summary of the Contact’s insurance and investment 
benefits. 

 
The Letters/Documents tab displays those letters and documents associated with the contact. 
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There are 60 Custom Fields available for tracking information that is unique to your business. 

 
Business Records 
The specially designed business Detail tab provides names, addresses and other facts about 
individual Business clients. 
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The Add’l Detail tab expands upon the Business’ Detail information. 

 
Store the Key Relations for a business as part of the business record and quickly access the 
Contact records from this tab. 

 

Client Data System® v6.0 - Getting Started Guide 
Revised: 12-27-05 

Page 25 



Use the Group Census information tab for employee records. Instantly sort employee data by 
any criteria (e.g., last name, compensation, hire date, date of birth, etc.). 

 
The Letters/Documents tab displays all of the letters and documents associated with the 
business. 

 

Client Data System® v6.0 - Getting Started Guide 
Revised: 12-27-05 
Page 26 



 

The Business Custom Fields tab has over 30 fields that you can customize to store categorical 
information about the business. 

 
Word Processing 
The Contact and Business record Letters/Documents tabs stores copies of all correspondence for 
instant retrieval of the entire document. Write letters using Microsoft Word or use the CDS 
internal word processor, E-Z Editor, by selecting Form Letter Maintenance from the expanded 
Tools menu. Click the OK button in the Find Form Letters dialog box to display the Form Letters 
List. 
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SmartPad: the Intelligent Notepad 
The SmartPad provides a consolidated view of events or activities related to a Contact or 
Business. Make a note, write a letter, schedule an appointment, add a policy or investment, place 
a telephone call, send a FAX—CDS posts notations for all of these events and activities to the 
Contact or Business SmartPad. Search a SmartPad by topic, keyword, or user—search any field 
that stores data. Filter the list to only display notes for a specific topic, date, type, etc. 

 
Activity Tracking 
Thoughtfully designed calendar windows enable efficient activity management. Daily, weekly 
and monthly calendar views accommodate a wide variety of scheduling practices. 

DayView Calendars 
Three views are available for the DayView 
Calendar. Click the DayView button to open 
the calendar; click the button again to change 
the view. Link calendar activities to contact, 
business, or policy records for an effective 
follow-up strategy. Sort and Filter daily 
activities by any criteria. Quickly identify and 
act on your best opportunities. CDS moves 
unfinished activities forward automatically 
each day, so you never miss an activity. Print 
your calendars in various formats to take with 
you when you are in the field. 
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WeekView Calendar
The WeekView calendar has two views: 
a summary view for listing activities for 
each day of the week, and a scheduling 
view for using drag-and-drop operations 
to quickly reschedule an appointment to 
another week 

MonthView Calendar 
The MonthView calendar provides a view 
of activities for the entire month. The right 
side of the window displays the schedule 
for the date selected on the calendar. Click 
the Previous and Next arrows to navigate 
easily to any month of any year. 

Messaging 
Send messages to other CDS users on your network; save messages to the SmartPad and refer 
these messages at your convenience. Recipients can easily reply to messages, making CDS 
messaging an efficient method for communication in the office. 
Sending a Message 
1. Click the Messages button to open the Messages window. 
2. Click the New Message button to open the Message Recipients dialog box. 
3. Select the name of the recipient(s) and then click the OK button. 
4. When the While You Were Out dialog box opens, enter the text of your message and then 

click the Send button. 
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Replying to Messages 
1. Click the Messages button to open the Messages window. 
2. Select the message that you want to send a reply to and then click the Reply button to open 

the While You Were Out dialog box with the sender’s original message. 

 
3. Enter your reply in the message box and then click the Send button. 
For more information, see the Online Help sub-topics under Messaging. 

Dialing Phone Numbers 
Click the Dial Phone button with an open Contact or Business record to display all available 
phone numbers for the record. Select a phone number on the list and then click the Dial button to 
dial the selected phone number through your computer’s modem. When you are finished with the 
call, CDS can automatically log this event in the SmartPad for the Contact or Business. 

 
For more information, see the Online Help sub-topic Dialing Phone Numbers under Contact 
(Client) Records. 
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Dynamic Reports 
Dynamic Reports™ is a powerful feature in CDS. Create a virtually unlimited number of 
Activity, Agent, Contact, Policy and Vendor reports with your own search criteria. For example, 
running the Dynamic Report “Birthdays next 30 days - All Contacts” produces a report that lists 
all Contacts who have a birthday in the next 30 days. Double-click any of the records on the 
report to access the underlying Contact record. 

 
For more information, see the Online Help sub-topic Dynamic Reports under Database Reporting. 
Policy Tracking 
CDS provides a complete policy tracking system. Policy information is categorized and displayed 
on a variety of tabs. Click a vertical tab on the left side of the Policy window to list policies by 
type and then click the horizontal tabs after selecting a policy record to view the policy details. 
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The Basic Information tab stores the details about a policy, including a list of all Interested 
Parties. 

 
The Benefits tab stores policy values and any Riders that the policy may have. 
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The Payment History tab displays the policy’s payment history. 

 
The Letters/Documents tab displays all the letters and documents associated with the policy. 

 

Client Data System® v6.0 - Getting Started Guide 
Revised: 12-27-05 

Page 33 



 
The Miscellaneous Information tab stores effective dates and contains several custom fields to 
store other important information. 

 
The Commissions tab displays all commission records associated with the policy. 

 
The Transactions tab stores the subaccount transactions for variable life and variable annuity 
policies. 

 
For more information, see the Online Help topics under Policy Records. 
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Glossary of Terms 
ALPHA KEY 

This is the default label for a customizable field that can be used for sorting or locating records. 

Category 

Specific classes or types of records that are grouped together. 

Character 

A character is any letter, number or symbol. Character fields may contain alphabetic characters, 
numbers and special characters unless the field is limited to one type of character. 

Client No. 

A unique number that CDS assigns to a Contact record when it is added to the database. 

Column Name 

The heading that displays in the first row of a spreadsheet that identifies each column of 
information. 

Columns 

A column is a series of data elements that are arranged vertically in a spreadsheet. 

Date Offset Symbols 

Expressions used in the Date Operations dialog box in place of an actual number (i.e., "nn" for 
"next", "cc" for "current", "pp" for "previous", "??" for "any"). 

Default 

A setting or value that will be used if no changes are made. 

Desktop 

The desktop is the first window that is displayed after logging in to the CDS program. 

Field Prompt 

A field prompt is the label that is adjacent to a data field that indicates the intended use for the 
field. 

Field Type 

The field type determines what kind of characters the field will accept. For example, an 
alphanumeric field type accepts letters and numbers, while a numeric field type accepts numbers 
only. 

Fields 

Fields are the data storage areas in database records. 

Global List 

A complete listing of individual items in one database table.  

Illustration 

A screen capture or other visual representation of information that is used for clarification. 
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Important Dates 

Events that are extracted from Contact records and used to automatically schedule activities. 
Important dates include dates of birth, policy renewal dates, and investment maturity dates. 

Index 

A reference to the location of records and key fields in the CDS database. 

Key Relations 

Dependents, other Contacts, or businesses that are associated with a Contact. 

Merge Code 

Merge Codes represent the data that is stored in specific fields of Contact or Business records. 
These codes are typically used to merge the unique data in Contact and Business records into 
common form letters and envelopes for mass distribution. 

Modal Factor 

The number that is multiplied by the total annual premium to calculate the amount of each 
payment when a premium is paid semiannually, quarterly, monthly, etc. For example, if the 
annual premium is $1,200, and the modal factor for PAC (pre-authorized check) monthly is 
.0875, the monthly payment would be $105. 

Numeric 

A number character (e.g., 1, 2, 3).  

Operator 

A symbol or word that is used to include, exclude, or otherwise differentiate between fields of 
data. 

Path Name 

The logical route that links two computers together; the drive specification, directories and 
subdirectories that identify the exact location of a target directory or file on a computer. 

Preferred Address 

The Preferred Address is a setting in Contact and Business records that indicates which address to 
use during a program function. 

Range 

The inclusive values (dates, numbers, characters, etc.) between one fixed point and another. 

Read Only 

Read Only is an attribute that is applied to files and records to prevent changes or deletion. 

Records 

A group of related fields in a database that describe a Contact, business, policy, etc. 

Recurring Activity 

A recurring activity is an event that occurs at regular intervals. For example, a production 
meeting that occurs every Tuesday at noon. 
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Set 

A Set is a group of records in a database that are categorically related. 

Sort Order 

The arrangement of records, or other database elements, in a specific sequence. 

Table 

A table is an orderly arrangement of data in rows and columns. 

Tag 

Tags are used to mark records for inclusion in a process. Typically, records are tagged by clicking 
a checkbox next to the name of the record. 

Type Field 

The Type Field is used to categorize contact records (e.g., Family, Client, Friend, etc.)  

User Profile 

The User Profile contains the preferences and security settings for the user. 

Validate 

To check and/or correct the relational integrity between the rows in different database tables, and 
to recalculate referential data. 
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